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Introducing The Poster Toaster

The Poster Toaster (TPT)is the ultimate way to create, send, and track
your eBay listings. Why? Because it gives you an easy way to do all
this and more:

B B B B B O

o

Edit your ads in either a WYSIWYG editor or an HTML text editor
Create ad templates that you can use over and over

Submit your ads in bulk

Upload your pictures using FIP (File Transfer Protocol)

Use merge fields to keep your repetitive work to a minimum
Organize your ads using folders

Track all your ads and find any one in a flash

Import your ads from Turbo Lister and Shooting Star

You can even track additional information about each ad — a
description so you can tell similar ads apart, your cost for the item,
weight, shipping insurance, and more.

The TPT window has three resizable panes that let you see exactly
what you are doing all the time.
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Pane 1: Folders and Ad History Pane 2: Ad Details

Scroll through Ads
Action Tools

i The Poster Toaster

=10l x|

000000 06

Fost Ste] DoolE di [Auctioname & [Tite] Detail | User Difined Fiskds |

@0

: E=
Title: le 1
= O eBap US sal :samp . :
Subtitle:
- (2 Gample [2]
el User Deser: |Th|s is & sample ad. |
Post Status: AdlD: EOT  Itemd; Modified: 7/7/2004 5:14 Pt
Userld: none + | Start D End Dt:
wiction Type: = {tem Location
£ Ayction EU' LT Lacation: [The Poster Toaster
€ Dutch auction uratien: 17 =l Country: — [United States -
" Fived prce item ['BIN cnly'] || M1 B OO0l e e iony — [Boa ot et regianall =
" Stores fived price auction |[F=== 0,000\,
Buy It Now L
it
e ncluds in Proximity Seard
eBay Schiduled Post Date: _

(T Tle Edit View Inset Fomat Table =
Xle@|fpR|lox|— 2@
1 iz ZA® B £ U=t

{Field:Title}
Put your pictures  [Put your description here.
here
Mfake sure you edit the "My Auctions" merge field (Tools
= Template Tags), Replace "YOTURID" with your eBay ’ﬂ
2l r
[Pas: 1 [ [Marmal [
DIl Edit | HTML
‘ | Caps .3|7ﬂ'9/2UU4T:ZEPJ ]
Editor Toolbar Pane Control Icons

Pane 3: Ad Content

Display all three panes at once, or use shortcuts to move between
them:

Left -click on any Pane Control Icon to switch between hiding
and showing the corresponding pane.

Right-click green | To fill the window with Pane 1, or
or use [Ctr]l]+1 restores Pane 1 to normal.

‘.‘ L®

Right-click red To fill or restore Pane 2.
or use [Ctrl]+2

Right-click To fill or restore Pane 3.
or use
[Ctrl]+3

e e®
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Setting Up The Poster Toaster

After just a little set up, you'll be ready to begin creating and
submitting listings. This section tells you all you need to know about
setting up TPT to:

@ Use your Internet connection
d Upload your pictures to your FTP site
d Submit your listings to eBay

To Begin

Select the Tools menu, then the Options command to open the dialog
you’ll use for all the setup.

File Edit Wew Post | Tools Help
Picture Manager
Template Tags
Send Images to Pending Upload  Chrl+I

Customize Grid
® Show Grid Summaty

Cpkions
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Set up the Internet Connection

When the dialog opens, it looks like this. Normally, you won’t need to
change any of these setting.

1. However, if your Internet connection uses a proxy, enter the
TCP/IP address here. Usually the Remote Port should be set to 80,
unless your ISP tells you otherwise

2. If you leave this field blank, TPT uses your default browser (as
configured in Windows) when you connect to the Internet. If you
want to use a different browser, enter the path and filename, for
example,

“C:\Program Files\Internet Explorer\IEXPLORE.EXE".

options x|
gﬂ FTP Mote: First try connecting without zetting the proxy field
= =] Auction Houzes
- M eBay Prosy | |
= | eBay LS
|E| 6B A Canads Remate Fart
m eBay UK ] Default Broveser | |
E eBay Australia
.. B eBap Motors
[ Other Settings
ok LCancel Apply
3. Click Apply.
Setting Up The Poster Toaster 7




Set up the Connection to Your FTP Site (or Sites)

When there are pictures in a listing you send to eBay, you must send
the pictures to your FTP site. Then the pictures are available along
with your ad. If you don’t already have an FTP site, check with your
Internet provider. Most Internet providers provide you with some
space on their server. Then you'll need to come back to this section to
tell TPT the information it needs about the site.

Here’s a sample FTP record to compare with yours as you go along.

i x|
? Internet
----- 5] FTF
[_]___ Auction Houses Default FTF: |www.pru:uvider.u:u:um j
= A eBay _
B2 eBay US IF file exists on server: £ Prampt me for each file
IEl REEaners ™ slwaps replace server file with new file
E eBay UK ¥ Mever ovenarite zerver fils.
E eB ap Australia
... B8 eBay Mators
-[E5] Other Settings P U e |.'-"3'-"USE’|D |
FTP Password  [eseons |
Femote FTF Host |www.pru:uvider.u:u:um |
FTP Port
Image URL |htt|:u:.-"f"www.prnvider.u:u:um.-"yuurLlserID.-"images |
Host Image DIR |images |
FTF Timeout E
[~ Dizable PASY
I«|1‘}|»I|+|—|J|X‘ﬂ‘ Test FTP Settings |
Ok | Cancel | Apply |

To tell The Poster Toaster about an FTP site:

o j) Don't get discouraged as you work through this process. Once
- you finish, everything else in TPT is easy and fun!!

1. Click the FTP icon 22{ll§ on the left side of the dialog. The right
side becomes filled with fields you use to set up connections to any
number of FIP sites.

2. If you have only one FIP site, just continue with the rest of the
instructions. If you have already set one up, and you want to set up
another, click the plus sign # to insert a new, blank FTP record.
Your other FTP records remain intact; you can scroll through them
by using these buttons:

L B
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. Now you have blank fields on the FTP setup dialog. Ignore the
Default FTP field for now. After you set up all your FTP sites, you
choose the one you want to use as the default.

. The option buttons tell TPT what you want to do in case you send a
tile to your FTP site, and a file with the same name is already there.

Should it:

¢ Prompt you to replace the file on the site or cancel the upload.

¢ Always replace the file on the site. (Be careful if you choose this
one; you might accidentally overwrite a file you wanted to

keep.)

¢ Never replace the file on the site. You'll have to make sure each
new file has a new name.

. Use the following table to fill in the fields in the bottom of the

dialog.

Field Name | What To Do

FTP User Type the user ID your provider assigned to you

ID when you acquired the FTP site.

FTP Type the password that goes with the user ID. Each

Password character appears as an asterisk, for security.

Remote FTP | Type the URL of your FIP site provider. Normally

Host this is something like www.provider.com, but it
might be a set of numbers, like “21.456.78.09”.

FTP Port Leave this set to “21” unless your provider told you
a different port number when you acquired your
FTP site.

Image URL | Type the full address of the folder where you store
images on your FTP provider. This isn’t the FTP
location of your picture files, but the image folder on
your server. For example, it might be:

“http:/ /www.provider.com/yourUserID/images”

Host Image | Type the destination folder on your FTP site, that is,

DIR the name of the FTP folder where the images will be

transferred. You can get this folder name from your
provider when you get the FTP site. It might be
something like “images”.

This is not the same text as the entry for the Image
URL. It is a different way of indicating the location of
your image folder.
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Field Name | What To Do

FTP Leave this set to “0” (no timeout) unless you know
Timeout your server is having problems, and you don’t want
to wait in vain for your pictures to upload. Then set
this to the number of seconds you are willing to wait
for the files to upload. If TPT can’t connect to the
server in that amount of time, it tells you it couldn’t
send the files.

Disable Most FTP sites use Passive mode, which is the
PASV default. If your FTP site requires Active mode, mark
this checkbox to cause TPT to use Active mode.

7. When you have entered all the information, click Apply.

8. If you want to set up another FTP site, complete steps 2 through 7
of this procedure again, for the new site.

9. Now, go back to the Default FTP field, and select the URL you will
use most often. When you upload pictures, TPT uses this URL
unless you choose a different one during the upload process.

10. Click Apply.

To test your FTP settings:

After you set up your FTP records, test each one by following this
procedure.

1. Use the M buttons to scroll to the record you want to

test.

2. Click the Test FTP Settings button.

Here's what TPT does during the test:

1. TPT checks to make sure it can establish a connection to the Remote
FTP Host. If it can establish the connection, it displays this message.
Click OK.

Your FTP connection is working properly.
The program will now try to upload a small picture.

2. TPT tries to upload a smiley face picture to the site. If it’s
successful, it displays a web page telling you about the success.
Close the window.

You did itll You're done with this. The rest of the setup is pretty
easy.
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Possible problems with the test:

If TPT has any problems, it displays an error message. The table below
tells you what to do in the most common cases.

Error Message What it means, and what to do

Host not found. This means the Remote FTP Host you entered
doesn’t exist. Correct your entry and try the test
again.

Login incorrect This means your user ID or password is not

correct. Correct your entry and try the test again.

[Host Image Dir]: | This might mean that you don’t actually have an
No such file or FTP site on the provider, or it might mean you
directory don’t have the correct Host Image DIR setting.
Check with your provider to make sure you are
set up correctly on the host and to find out the
FTP directory where you can store your pictures.
Make any necessary changes and try the test
again.

Not using the built in FTP at all.

If you do not wish to use the automated FTP feature, remove all entries
in the FTP table by using the minus button at the bottom of the form.

Setting Up The Poster Toaster




Set up Your eBay Accounts

In this next procedure, you tell TPT the information it needs to know
to complete your ads when it sends them to eBay.

Enter your eBay UserID:

1. In the left side of the Options dialog, Auction Houses | eBay.
Enter your eBay User ID. Your eBay userID is the same for all
auction houses.

options x|

Internet
FTP
Auction Houses

o eBay S
E eBay Canada
m eBay UK
E eBay Australia
.2 eBay Matars
Otk Settings

eBay Usger [Ds

Uge the "+" button at the bottom of the grid to enter new UserlDs

AuctionUser D v
M [VouEbaylD

AFF=—xXo [4] >

Request Mew Token |

] | LCancel | Spply |

2. Use the information in the following table as you set up your
account information.

Field Name | What To Do
Auction Click the plus sign (#) to add a row to the table.
UserID

Enter your eBay user ID.

If you have another eBay ID, click the plus sign (#)
to add another entry row. Then enter your Auction
ID.

Note: The first time you Verify or Post an ad to eBay, you will be
presented with the eBay login screen. Enter your password and

read the following pages. When you are done, eBay will generate a
token which TPT will use to authenticate you with eBay. TPT does

not store eBay passwords.

Tokens expire in three different ways:

Setting Up The Poster Toaster
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1.The token expires naturally. Each token has a set expiration date
which is currently set at 18 months.

2.You change your password on the eBay website.

3.eBay force expires the token for security reasons.

Enter your eBay Account Information:

1. In the left side of the Options dialog select the eBay house where
you have your account. Nearly everything is already set up for
you. You just fill in your details.

opions x|
Intermet Auction Info | Stare Categaries
J FTP_ eBay 15
E-Eg Auction Houzes : 5
g Achve Auction: v
eBay LS Currency: % 1S Drallar
] g eBay Canada Location: | |
-E eRap LK ; .
; R oy Australia Caunry: |Un|ted States J
... eBap Matars Fegion: |D|:| hit lizt regionally j
& Other Setlings Defaul ltem Picture URL:  [hitp.//66.135.192.223/aw/pics/star 1 1.gl |
Fay Pal Email: | |
Default UserlD: | j
Zip: |

Include in prosirity search: [

Edit eBay Uzerl Dz |

] | LCancel | Apply |

2. Use the information in the following table as you set up your
account information.
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Field Name

What To Do

Active Mark this box to have TPT post your ads to this eBay

Auction store.

Location Enter the city and state (or other text) you want to
appear in the Location field on your eBay ad. This
becomes the default in all your ad details. You can
change it for a specific ad if you want.

Country Select your country from eBay’s list of countries.

Region Select your region from eBay’s list of countries.

Default Having an entry here means you will always have a

Item Picture
URL

b

camera icon beside your listing if you include a picture
in your ad. If your ad doesn’t include a picture, TPT
removes the default picture URL before it posts your
ad.

This field is already set up to use the standard eBay
shooting star icon on eBay’s site. If you want to use a
different default picture, enter the URL for the picture.

Pay Pal
Email

If you have a Pay Pal account that you use for receiving
payments, type in your email address for the account.

Default User
ID

If you entered more than one User ID, select the one
you use most often.

Zip

Include in
Proximity
Search

Applicable to eBay US and eBay Motors only

Zip is the default zip code for the seller’s location. The
zip code is used in proximity searches on eBay. You
must fill in a zip code if Include in Proximity Search is
checked.

3. If you use other eBay auction houses, repeat steps 2 and 3 for each

one.

4. Click OK.

Or, click the Store Categories tab and set up your categories.

Setting Up The Poster Toaster
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Set up Your Store Categories

If you are setting up an eBay store, use this tab to identify the
categories in your store.

options x|
g Intermt Auction lmfo Store Categories |
) FTP

El-Jeg): auction Houses Changing the stare cateqory descriptions in The Poster Toaster DOES MOT

EI)-' =Bay change them on eBay. These descriptions are for user clanfication only and are
% efay US not transmitted to eBay. 5 :
.-.I#1 gfay Canada Synchronize Store Categories
g Zg:ﬁ .E«Estralia Store Categary Dezscription -
BB eBay Motors Jackets

-] Other Settings Shaes
Pantz
Sharts

P |Category
Category B
Category 7
Category 8
Category 9
Category 10
Categary 11
Cateqaoryl12 =

ok | LCancel | Anply |

¢ To change the name of a category, click in the row and type the
new name. The new name appears automatically in all ads
using that category.

¢ To have the category names assigned to the categories for all
eBay stores, click Synchronize Store Categories. Then click Yes.
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Other Settings

1. In the left side of the Options dialog select Other Settings.

Internet
9 FTP Other Settings
: - Auction Houses
. O eBap Remawve picture I 30 3: days after auction ends
E eBay US [~ Keep pix on server after auction for all ads.
et eg‘” E;”ada ¥ Use The Poster Toaster WAYSIWYG HTML Editor
: eBay

B eBay Australia
B eBay Motars

Other Settings

[~ Hide Fees Summary windaw after Yerify
[~ Hide GalleryURL and PicturelRL in Preview

] | LCancel |

Apply |

2. Use the information in the following table as you select your

options.

Setting Up The Poster Toaster
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Field Name | What To Do

Remove Select the number of days TPT adds to the auction end
picture XX date to determine when an ad has expired. TPT will
days after remove pictures from your FTP server for expired ads
auction when you press the “Remove Expired” button in the
ends. Picture Manager.

Keep pix on | Mark this box if you want to keep the pictures on the

server after
auction ends

server after the ad has expired. Selecting this option
will set the default for all new ads. This has the effect

for all ads of setting all pictures in an ad to “stock” pictures which
remain on the server until you decide to remove them.
Use The Uncheck this box if you do not wish to use the included
Poster WYSIWYG editor. This option is for users who use
Toaster another tool to create the Description HTML and paste
WYSIWYG | their HTML directly into the HTML tab. Unchecking
HTML Editor | this box disables the WYSIWYG editor and prevents it
from modifying the HTML.
Hide Fees Mark this box if you do not wish to see the Fees
Summary Summary window after you Verify an ad.

window after
Verify

Hide Gallery
URL and
Picture URL
in Preview

Mark this box if you wish to hide the Gallery URL and
Picture URL pictures from the ad Preview. (The
Preview button is located on the WYSIWYG HTML
editor toolbar and is the magnifying glass and piece of

paper)

You're completely done with all the setup.

You won't need to do any of this again unless your information

changes.

Setting Up The Poster Toaster
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Creating an Ad

This main section tells you all you need to know about creating an ad
to post on eBay. It tells you how to:

d Start a new ad — either blank or by copying a template ad
d Enter the ad details in Pane 2 of the TPT window.
d Enter the ad content, pictures, and template tags in Pane 3

d Preview and proof your ad

Starting a New Ad

TPT comes with two pre-designed ad layouts. When you create a new
ad, you can use one of the TPT layouts, one of your previous ad
layouts, or a blank one.

To start a new blank ad:

Click the New Ad tool at the top of the window. A new row is added
to the Ad List and Panes 2 and 3 are blank, ready for you to begin.

To start a new ad, using a previous ad as a template:

1. Look through your list of ads (just to the right of the folders). Find
the TPT layout or previous ad you want to use as a template. Click
it to select it.

2. Click the Copy Ad tool at the top of the window. A copy of the ad
appears in the Ad List and Panes 2 and 3 contain the same
information as the ad you copied.

3. Make changes to the ad, and then click the Save Ad tool to save o
the ad.

Note: To delete an ad, select it in the list of ads, and click the Delete @
Ad tool.

Entering the Ad Details

Pane 2 of the TPT window (upper, right pane) contains fields for the
ad details. Most of the fields are standard fields required by eBay; they
provide the same information you give if you post directly through
eBay’s website. If you need more information about what to enter in
those fields, look through eBay’s help (go to www.ebay.com and click
the Help button).

Creating an Ad 18



Fields supplied by TPT to help you track your personal information
about your ad are highlighted in green. This section explains what you
need to know about those fields.

1. Right-click the little red circle at the bottom, right corner of the .l
window. This causes Pane 2 to fill the screen, making it easier

for you to work. (Right-click it again to restore the other

panes.)

2. Work your way through all the detail fields, completing all the
information as you go. We suggest starting at the top and moving
down through the fields to make sure you don’t miss any.

Use the information in the following table as you work. It lists all the
tields and explains what to do in each case.

Notes:

¢ You can set up a template tag for any of these fields (see page
48). Then if you insert the tag into your ad content, the text in
the field replaces the tag when your ad it posted to eBay.

¢ Green fields on the TPT window indicate information that is not
used by eBay. It is for your personal tracking. In the following
table, these fields are explained in green text.

¢ Some features cost extra on eBay. These features have a red
label on the TPT window and in the table below.

Field Name What To Do

Title Type the title you want to appear on eBay - 55
characters maximum.

User Descr Type a description to help you distinguish this ad

from others that may have the same title.

Post Status

These fields are automatically completed by TPT.

Item # They give you information about a posted ad.
Modified

Start Dt

End Dt

UserID Select the user ID to use for this ad. The list contains

the user IDs you entered for the eBay auction houses.
(See page 12.)

Auction Type

Select the type of eBay auction for this ad.

eBay Scheduled
Post Date

If you don’t select a date, the ad is posted when you
send it. To schedule a post date, click the down arrow
to display a calendar. Then select the date you want
the ad to be posted.

Creating an Ad
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Field Name

What To Do

Quantity
LotSize
Duration

Min Bid
Reserve

Buy It Now
Private Auction

Enter the information required by eBay. For
instructions, refer to eBay Help.

Location

Country

Region

(the following fields are for
eBay US and MO only)
Zip

Include in
Proximity Search

These fields contain the settings you entered for your
eBay account (page 11) appears here. You may change
them for this ad if you want.

Cost Enter your cost for the item, if applicable.
Stock No Enter your stock number, if applicable.
Consign ID Enter your consignment ID, if applicable.

Keep pix on server
after auction

Mark this box if you want TPT to leave the pictures
for this ad on your FTP site after the auction is over. If
you don’t mark this box, TPT will delete them during
your next post after this auction.

Category

Select the ad category from eBay’s list of categories.

Category2

If you want to place the ad in a second category, select
that category here.

Store Category

If this item is to be listed in a category of your own
eBay store, select the category. Set up the categories
when you set up or edit your eBay Account
information (see page 16).

Bold Your listing appears in bold face, like this.

Border (usandca Your listing will have a border around it.

only)

Home Page Your listing is included in a list to be featured on the
Featured eBay Home Page.

Featured Plus

Your listing appears in the Featured Items list of its
category, in addition to the non-features list.

Creating an Ad
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Field Name

What To Do

Show as Gift The gift icon beside your ad. #
Be sure to mark the type of gift services you offer.
Counter Select the type of counter you want to insert at the
bottom of your ad.
Gallery Mark this box to include a thumbnail picture beside

your ad in the eBay listing.

Gallery Featured

Mark this box to have your item periodically appear
in the special featured section above the general
gallery.

Gallery URL Use the button at the right of the field to select an
image file on your hard drive.
Or, you can enter the URL of the gallery picture
directly into this box.

Picture URL Your default item picture URL appears here (see page

14) You may change it if you want.

Use the button at the right of the field to select an
image file on your hard drive.

Shipping Costs

Mark the box “Yes, I'm specifying shipping costs” if
you wish to include shipping information.

Shipping Type

If you chose to specify shipping costs, choose whether
to use a flat shipping rate or have eBay calculate the
buyer’s shipping rate depending on additional
information such package weight and carrier.

Ship To Locations

Mark the button that indicates the locations you will
ship to. If you select US and Regions Below, mark the
regions you will ship to.

Creating an Ad
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Field Name

What To Do

Flat Shipping Rate
Details

If you chose to specify a flat shipping rate for the
buyer to pay (see Shipping Options and Shipping
Type), enter this information:

You can choose up to three different services.

Shipping Service. Select a service from the list. You
can enter three different services for the buyer to
choose from.

Shipping Handling. Enter the amount.

Each Additional Item. This set of fields will appear
only if the quantity is greater than 1. Enter the
amount if necessary.

Shipping Insurance per Item. Enter the amount. Then
select the explanation from the drop-down list to
the right of this box.

Sales Tax. Enter the percentage. For example if the
percentage tax is 8.5%, type “8.5”. Then select the
state from the drop-down list to the right of this
box.

Apply sales tax ... Mark this box if the sales tax is to
be applied to the final total. Otherwise, it will be
applied only to the item cost.

Insure For. If you choose to insure the item, enter the
amount the item is to be insured for.

Weight. Enter the weight of the item.

Payment instructions and return policy. Enter this
information to be included in your ad and in the
email to your buyer when the item sells.

Creating an Ad
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Field Name

What To Do

Calculated
Shipping Rate
Details

(US only)

If you chose to specify a calculated shipping rate for
the buyer to pay (see Shipping Options and Shipping
Type), enter this information:

Weight. Enter the major (Ibs) and minor (0z) weight.

Package size. Select a package size from the list.

Irregular pkg. Mark this if package is an irregular
size.

Shipping Service. Select a service from the list. You
can select up to three different services for the
buyer to choose from.

Packaging & handling fee. Enter the amount needed.
Seller zip code. Enter your zip code.
Insurance. Select insurance from the drop down list.

Sales Tax. Enter the percentage. For example if the
percentage tax is 8.5%, type “8.5”. Then select the
state from the drop-down list to the right of this
box.

Apply sales tax ... Mark this box if the sales tax is to
be applied to the final total. Otherwise, it will be
applied only to the item cost.

Insure For. If you choose to insure the item, enter the
amount the item is to be insured for.

Weight. Enter the weight of the item.

Payment instructions and return policy. Enter this
information to be included in your ad and in the
email to your buyer when the item sells.

Payment Options

Mark the checkboxes that indicate how you will
accept payment. If you entered a Pay Pal email
address in your eBay account setup (page 11), it
appears here. You may change it if necessary.

Be sure to mark the correct Escrow button.
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User Defined Fields

Click on the “User Defined Fields” tab to edit the ad’s User Defined
Fields (UDFs). There are ten text fields and four memo fields. You can
use these fields to store any data specific to the ad. The labels are
editable and persistent. The modified labels are stored in the
ThePosterToaster.ini file.

Detal  User Defined Fields |

— | Main Picture C:5my documentsytptiface] jpg ™ .
IDF Text 2
LIDF Text 3
LDF Text 4
LIDF Text5
LIDF Text &
LIDF Text ¥
LDF Text 8
LIDF Text9
UDF Text 10

L | UDFMemo1 ﬂ

Labels are editable File dialog buttons

The UDFs are available to the Global Search and Replace function and
are template tag-able.

Entering the Ad Content and Pictures

You enter your ad content in Pane 3 of the TPT window (lower, right
pane). It's easy to use the WYSIWYG (What You See Is What You Get)
editor on the Edit tab, since you can see what the ad looks like as you
work. But in some cases, you might want to edit the HTML text
directly. Just click the HTML tab to see the HTML text that TPT creates
for you from your work in the easy editor.

To create or edit your ad content:

Note: You must complete the ad details (page 20) before you can begin
editing your ad content.

1. Right-click the little yellow circle at the bottom, right corner .'
of the window. This causes Pane 3 to fill the screen, making 4
it easier for you to work. (Right-click it again to restore the
other panes.)

2. Click anywhere inside the editor.
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3. Type your text and use the Editor Toolbar tools to insert template
tags, create tables, format your text, and/or insert pictures to create
your ad. The table that follows explains the tools on the Editor

Toolbar.

Tool

How To Use It

=]

Save. Save occasionally as you work by clicking
this tool. Save also when you are done before you
post the ad.

<

Stop. Similar to the Stop button in the browser, this
button halts the editor from attempting to
download. For example, if you have inserted a link
to a picture that doesn’t exist, and the editor is
trying to download it, click this button to stop the
attempt.

Reload last saved HTML. Click to reload the editor
with the last copy of the HTML saved in the
database.

Preview. Click to display your ad as it will appear
on eBay, including the text for template tags, the
counter, and all pictures. To close the preview
window, click the Close box in upper right corner
of the window.

¥ Cut. Cuts the selected text or object to the clip
— board.
Copy. Copy the selected text or object to the clip

board.

Paste. Paste the current object on the clip board to
the editor.

3 B

Undo. Click to undo your most recent editing action
(type, delete, insert picture, format font, and so on).
Click again to undo the previous edit.

Redo. Click to redo your most recent undo
operation.

Font Formatting. Highlight the text you want to format and use these
buttons to set the formatting

Fonts. Select the font and size from the drop down
lists. The default font is based on the Internet
Explorer default. You can change this in IE using
Tools | Internet Options | General tab | Fonts...

Bold. Toggles the selected text between bold and
non-bold face.
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Tool

How To Use It

Ttalics. Toggles the selected text between italics and
non-italics.

&l N

Underline. Toggles the selected text between
underline and not.

>

Font fore color. Opens a dialog on which you can
select the font fore color.

3

Font back color. Opens a dialog on which you can
select the font back color.

Paragraph Formatting. Place the cursor in the paragraph or paragraphs
you want to format and use these buttons to change the format.

R
111

Numbered list. Sets the paragraphs to a numbered
list, with automatic sequential numbers.

Bullet list. Sets the paragraphs to a bullet list.

Indent less. If the paragraph is indented, this
decreases the indent by about %2 inch.

Indent more. Increases the indent by about %2 inch.

]| R

Left justify. Left-justifies each line of the
paragraph.

Center. Centers each line of the paragraph.

Right justify. Right-justifies each line of the
paragraph.

Justified. Right and left justifies each line of the
paragraph.

Inserting Special Features

]

Insert horizontal rule. Inserts a full horizontal line
at the location of the cursor.
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Tool

How To Use It

=

Insert image. Opens a dialog you use to insert a
picture at the location of the cursor.

a Picture

Picture Source: II::\MyPictures\tiffanylamp.ipg Browse... | ITI
Alkernate Text: ITiffanyLamp Cancel |

Layout Spacing

Alignment: IBaseIine v| ﬂulizuntal:l
Border Thickness:l Werticak I

Picture Source. Click the Browse button and select
the picture you want to insert.

Alternate Text. Type a label for the picture. If there
is a problem displaying the picture in your ad,
this text appears beside the box with the red X.

Alignment. Select the position for the picture,
relative to the text around it.

Layout Not set positions the
Alignment; Eazeline : image in line with the

Mat set text, as if it were a
Border Thickness: |Left character

Right .

Testiop Left and Right apply

NUIMM to the horizontal
ggﬁb;,:mm alignment: left of the

Middle text or right of the
Tap text.

All others apply to the
vertical alignment.

Texttop = Aligns the top of the image with the
top of the highest character in the text line.
In some browsers, this behaves the same as
llTop.ll

Absmiddle = Aligns the middle of the picture
with the middle of the text

Baseline = Aligns the bottom of the picture with
the baseline of the text (not including
descenders on characters like g, j, p, and y).
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Tool

How To Use It

Insert image (continued)

Absbottom = Aligns the bottom of the picture
with the absolute bottom of the text,
including descenders on letters like g and j.

Bottom = Aligns the bottom of the image with
the bottom of the text. In most browsers this
is the same as “Baseline.”

Middle = Beware. In some browsers, this aligns
the middle of the picture with the middle of
the text. In others, it aligns the middle of the
picture with the bottom of the text.

Top = Aligns top of the picture with the
theoretical top of the text.

Insert or modify link. Select the text you want to
hyperlink. Then click this button to set up a link or
modify the existing link on the text.

Bk ]

Hyperlink Information

0K
Type: I hittp: - I

Cancel

URL: Ihttp:waw.pruvider.cuma’m}lfile.html

L RE

First select the Type of link. Tupe: | hitp:
TPT sets up the URL in the [other]
correct format. ;'t';f
Then type the rest of the URL. ﬂ%
hitps:
rnailta:
FIEWE
telnet:
waig:

Insert template tag. Position the cursor where you
want the template tag. Then click this button to
open a dialog with a list of your tags. Select the one
you want to insert and click OK.

For more information about template tags, see page
47.
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Editor Menus

Menu | SubMenu

Description

Load From File...

Allows you to load an HTML file from

File your hard drive into the editor.
Save to File Allows you to save the HTML in the
editor to a file
Vie Text Size Set the text size viewed in the editor.

W Text size does not modify the underlying
HTML. Use the preview to see exactly
how the ad will appear on eBay.

Details Shows hidden tags, anchors, and other
elements as glyphs
<BR> Tags Shows break tags as glyphs.
Comment Tags Shows comment tags as glyphs
Insert Picture Brings up the Insert Picture dialog (see

page 29 for more details)

Horizontal Line

Inserts a horizontal line at the cursor
location.

Hyperlink

Select the text you want to hyperlink
tirst. Then select this menu item to bring
up the hyperlink dialog.(see page 30 for
more details)

HTML...

Brings up HTML dialog. Enter your
HTML and press OK to save. The HTML
will be inserted at the cursor location.

Comment...

Brings up Comment dialog. Enter your
comment and press OK to save. The
comment will be inserted at the cursor
location. Comments are only visible in
the HTML tab.

Line Break

Inserts a <BR> tag at the cursor location.
The BR tag inserts a break in the current
line of text

Paragraph

Inserts <P id=undefined></P> at the
cursor location.

Division

Inserts <DIV>&nbsp; </DIV> at the
cursor location.
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Menu

SubMenu

Description

Insert

No-Break Space

Inserts &nbsp; at the cursor location.

Template Tag

Position the cursor where you want the
template tag. Then select this menu item
to open a dialog with a list of your tags.
Select the one you want to insert and
click OK.

For more information about template
tags, see page 47.

Format

Style

Changes the style for the currently
selected text or line. Available styles:

Normal Removes all formatting

Formatted Preserves whitespace by
using a fixed pitch font. Used for
displaying code or poetry where the
alignment is important. Uses the HTML
PRE tag

Address Used to display contact
information for a document. Uses the
HTML ADDRESS tag

Heading 1 - 6 Used to define different
headers. Uses HTML
H1,H2,H3,H4,H5, or H6 tags.

Numbered List Used to create a
numbered list. Uses the HTML OL tag.

Bulleted List Used to create a bulleted
list. Uses the HTML UL tag.

Directory List Used to create directory
lists. Directory lists are multicolumn
lists though many browsers ignore this
tag and render it the same as a bulleted
list. Similar to a bulleted list. Uses the
HTML DIR tag
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Menu

SubMenu

Description

Format

Style(continued)

Menu List Used to create menu lists.
Menu lists are short single column lists.
Similar to a bulleted list. Uses the HTML
MENU tag

Definition Term Used to define a term
in a definition list. Uses the HTML DT
tag.

Definition Used to define the definition
description in a definition list. Uses the
HTML DD tag

Paragraph Used to create a paragraph.
Uses the HTML P tag.

Font...

Opens a dialog on which you can select
the font name, style, size, and special
effects.

Paragraph
| Alignment

None. Removes justification for each line
of the paragraph.

Left justify. Left-justifies each line of the
paragraph.

Center. Centers each line of the
paragraph.

Right justify. Right-justifies each line of
the paragraph.

Justified. Right and left justifies each
line of the paragraph.

Paragraph |Bullets

Numbered list. Sets the paragraphs to a
numbered list, with automatic sequential
numbers.

Bullet list. Sets the paragraphs to a bullet
list.

None. Removes the listing from selected
paragraphs.

Increase Indent

Increases the indent by about 2 inch.

Decrease Indent

If the paragraph is indented, this
decreases the indent by about %2 inch.

Background
Picture|Clear

Removes background picture.
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Menu | SubMenu Description
Format Background Opens a file dialog on which you can
Picture|Choose | select an image file for your background
picture.
Page Properties.. | Brings up a dialog on which you can
enter a Title and define the colors for the
Text, Link, Visited Link, Active Link and
Active Link for the page
Table Insert|Table.. Position the cursor where you want the

table, then click this to insert a table. On
the dialog that opens, choose the settings
that define the table.

Rows, Columns. Set the number of
rows and columns in the original
table. Normally, select the highest
number of columns you will want
in any row. You can delete or
insert either one using the other
tools.

Caption. Sets the caption for the table.
The caption appears above the
table.

Width. Sets the width of the table.
The width is in pixels unless you
check the % box. The percent box
will set the width as a percentage
of the browser’s viewing area.

7% Box. Mark this checkbox if you
want the table width to be
determined automatically based
on the content and the browser.
Or, unmark it if you want to
define the width of the table in
pixels.

Cell spacing. Set the amount of space
(both horizontal and vertical)
between the cells in the table. The
value indicates the number of
pixels. If you use borders, this
value determines the width
between the cell borders.
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Menu | SubMenu

Description

Insert Table

Table (continued)

Cell padding. Set the amount of space
(both horizontal and vertical)
between the cell wall and the
contents. The value indicates the
number of pixels.

Alignment. Set the alignment of the
entire table within the ad space:
left, center, or right.

Border Width. Select the number of
pixels for the width of the border.
Select “0” if you don’t want the
table to have a visible border.

Border Color. Select a color for the
table border.

Background Color. Select a color for
the background of the table.

Picture. Use the ellipses button at the end
of the field to display the file select
dialog box. Select an image file to use as
a background for the table.

Cell Attributes The cell attributes will be
enabled if the cursor is in a table cell of
an existing table and “Table/Cell
Properties” is selected from the Table
menu.

Alignment. Set the horizontal
alignment of the selected cell: left,
center, or right.

Vertical Alignment. Set the vertical
alignment of the selected cell: left,
center, or right.

Border Color. Select a color for the cell
border.

Background Color. Select a color for
the background of the cell.

Picture. Use the ellipses button at the end
of the field to display the file select
dialog box. Select an image file to use
as a background for the cell.
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Menu | SubMenu Description
Insert|Column Inserts a column in a table to the left of
Table
the cursor.
Insert|Row Inserts a row in a table above the cursor.
Insert|Cell Inserts a cell in a table to the left of the

cursor.

Delete|Column

Deletes the column where the cursor is
located.

Delete|Row

Deletes the row where the cursor is
located.

Delete|Cell(s)

Deletes the cell where the cursor is
located.

Merge Cells

Merges two adjacent cells together. Hold
the shift key down while clicking on the
cells to merge, then select Merge Cells
from the menu.

Split Cell

Splits the cell where the cursor is located.
You may have to double click the cell
to select the cell.

Table/Cell

Properties...

Brings up the same dialog used to create
a new table. However, you can now use
the Apply button to apply your changes
to the table to see what it will look like
before closing the dialog.

Show Invisible
Gridlines

Shows grid lines if the border width of
the table is set to zero. The gridlines will
only show in the editor and will not
appear when previewed or posted.
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Automatic Image Upload and Link Modification

If your FTP server is properly defined in the FTP Options, TPT will
automatically upload local image files to the FTP server and modify
the link in the HTML to point to the server. Link modification occurs
after the Template Tags are replaced. This allows you to define images
in template tags. Local images are modified based on the table below:

HTML object

Description

<IMG>

Image tag. This is the basic image tag. Simply
insert the image using the Insert Image button on

the toolbar. TPT will automatically modify the link

before it posts to eBay.

<A>

Anchor tag. TPT will only upload and modify

images in anchor tags if it is prefixed with “files///”.

All other references will pass through untouched.

Scripts

Scripts. TPT will only upload and modify images
in scripts if it is prefixed with “file:///”.
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Verifying and Posting Ads

Verifying an Ad

After you create an ad, you can verify that the ad will post successfully
before you attempt to post it to eBay. This is particularly handy if you
have to establish a dial-up connection to the Internet.

To verify an ad:

1.

Select one or more ads in the Ad List (middle panel on the TPT

window).

Click the Verify tool.

. TPT displays a message box asking you to confirm and reminding

you that the ads will not be posted through this command. Click

OK.

. TPT verifies all the selected ads and

displays the results of the verification in a
dialog. If eBay detects an error in the ad,
the Error Window will appear. If the ad
verifies correctly, the Fees Summary
window will appear with a list of the fees
the ad will incur. You can also access the
Fees Summary window from the View
menu.

Insertion:
Reserve:
Fized Price Duration:

Subtitle:

Home Page Featured:
Featured Plusl:
Highlight:

Border:

Bald:

Listing [ esigner:
Gallery:

Gallery Featured:
10 day Auction
Scheduled Listings:
Buy [t Mow:

Gift lcon:

Additional Photos:
Phata Display:

110

0.50

5.00

1.00

0.2s

025

Total Listing Fee:
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Posting Ads

It’s so easy to post a single ad or a group of ads. Here’s all you do:

1. Select one or more ads in the Ad List (middle panel on the TPT
window).

2. Click the Post Selected Ads tool. @

See “What happens when you post” on page 42.

Posting Batches of Ads

As you create ads, you can add them to a “pending” list. Then when
you are ready to post, you simply post the batch of pending ads and all
the ads are posted.

To add to the pending list:

1. Select the User Folder where you saved the ad.

2. Select the ad in the Ad List, or select several ads.

3. Click the Add to Pending tool. @

An un-toasted bread icon [ appears in the ad’s Post Status column of

the Ad List, and the Post Status on the ad details pane shows that the
status is Unlisted. The ad also appears in the Pending list (see page

52).
To remove an ad from the pending list:
1. Click the Pending button to display the list of pending ads.

2. Select the ad in the list of pending ads.
3. Click the Delete Ad tool. @

The ad is removed from this list but remains in the folder where it
resides. The un-toasted bread icon is removed from its status column.

To post the pending files:

When you post the batch of pending ads, all the Pending ads are
posted to eBay at once.
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¢ Click the Post Pending Ads tool. @

What happens when you post:

¢ TPT displays a message asking you to confirm and telling you
the ID of the batch that will be posted. The batch ID indicates
the date and time you chose to post the batch. It is in the format:

YYYY-MM-DD-hh-mme-ss, for example 2003-04-21-14-19-26
Click Yes to continue with the posting.

Note: Even if you are only posting one ad, TPT creates a batch
containing it when it is posted. You can review details about the
batch through the Batch Summary command on the View menu.

¢ TPT then displays a Posting Status dialog telling you the
progress of the post. When it is done, the Batch Summary dialog
opens, showing the batches posted during the current TPT
session. For example, the following picture shows that the batch
identified at the top of the dialog contained one ad, which was
successfully posted.

To see an explanation of any errors, select the View menu, then
Error Window.

Posting Statu x|

Processing Batch... ;I
Ad: eBay 1S Tiffany Lamp T
Loading pictures to zerer B 5 . e
Sending data to eBan...
Record not posted due to emors Batch ID: (2003-04-21-14:19:26 j
Ad: E_Ba_l,l |__|S Brazz Crab D PDEEd .
Iéuaddl_ng F'd":tturfs tg Servel Auction Posted | MoFees  Emars Total
ending data toeBay...
[tem posted eBay IS oy )] 2
<l
C Click grid to Filter records. Batch Total: ?

l Be-Post Batch Yerify Batch

¢ The Batch Summary window also acts as a filter. You can click
on any of the boxes to filter the grid. If want to see just the
posted ads, you can click on the posted icon. If you posted to
multiple auctions, you can click on the auction name to filter by
the auction.

¢ C(lick Close on the Batch Summary. Then click Close on the
Posting Status dialog. The status indicators shown on this
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dialog then appear in the Status column of the Ad List for the
ads in the batch.

Viewing Posted Ads on eBay

In the Posted view, select an ad and select “View Ad on Web” from the
View menu or press Ctrl+W. TPT will bring up the browser with the
posted ad.

Posting Errors

If an ad generates an error, the Post Status icon in the ad list will
change to a burnt toast and any errors will be written to the Error
Window. Any ads which produced errors during posting will be
placed in the Pending view. Corrections should be made in the
Pending view before re-posting the ads. Any corrections should also
be made on the parent template if the template is to be used again.

The Error Window automatically comes up if the ad generates an error
while posting or verifying. You can also bring up the Error Window
from the View menu.

%2 The Poster Toaster
File Edit | Yew Post Tools Help

Erraor wWindom
M« Batch Summary
) Fees Surnmary
[@ Wiew fd om Web Skl

There are two types of errors which prevent ads from posting. eBay
errors and system errors.
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eBay Errors

When you post or verify an ad, eBay checks the data sent for
correctness. If a required field is missing or a field value is incorrect,
eBay will return an error message regarding the problem. Ads with
errors are not posted.

eBay error messages have the following format:

eBay Error Code | eBay's error code number

Error Class: Possible values:

SystemError = An error has occurred on the eBay
side. This could be a downed database or server.
The request must be re-submitted.

RequestError = An error has occurred as a result of
incorrect or missing data in the request sent to
eBay. Data needs to be corrected and re-
submitted.

Severity: Possible values:

SeriousError =Error prevented ad from posting
correctly

Warning =Ad was posted to eBay but an error was
returned

Error Message: Description of the error

_lolx

eBay Emor Code: 35 -
Error Clasz:  ReguestEror
Severity: SeniouzE rmaor

Error Meszage:  Invalid user name or password, The
uzermame/pazaword pair zpecified far the uzer iz not valid.
“'ou may niotb uze an email address as a ugername if the
member has a Uzer D,

[

eBay errors can be somewhat cryptic. For a list of some of the common
eBay errors and how to resolve them, check the “eBay Error Messages”
forum at http:/ / www.thepostertoaster.com/forums/.
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System Errors

System errors are generated by TPT and include FTP and internet
connectivity errors and form validation errors.

FTP errors

FTP errors only occur when posting an ad. Verifying an ad skips the
FTP process and only sends the ad data to eBay for validation. It's
possible for an ad to Verify correctly but still produce FTP errors when
posting. If TPT cannot upload an image file correctly or cannot
connect to the FTP server, TPT generates an error and does not post

the ad.

Error

How to resolve it

File is formatted
incorrectly. Check HTML
img tag for extra double
quotes.

TPT cannot resolve the filename in the ad
HTML. Check the images in your ad HTML
for breaks in the filename or extra double
quotes.

Xxxx,xxx file doesn't
exist or is formatted
incorrectly.

TPT cannot find the file specified. Make sure
the file exists in the specified directory.
Check the spelling of the file. Check the
formatting of the filename in the ad HTML.

Check the Pending Upload tab in the Picture
Manager. Find the filename in the list and
check the error message.

Error connecting to FTP
server

Socket Error # 10061

Connection refused.

TPT cannot connect to the FTP server. Make
sure you are connected to the internet. If you
are running a firewall, make sure TPT has
full access through the firewall. Check your
FTP settings in the Options dialog. Run the
FTP test to ensure that your settings are
correct.

Other socket errors

Socket errors are external to TPT and usually
indicate a connectivity problem. The
problem could exist between your computer
and the internet, between your computer and
the server or a problem with the server itself.

For a detailed description of the various
socket errors, check:

http:/ /sockets.com/a_c.htm
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Form Validation Errors

Form validation errors are generated when an ad is saved. If an ad is
missing data or has invalid data, an error message is written to the
Error Window. The Error Window will appear if the Save button is
pressed. If the user moves to another record, any errors are saved with
the record but the Error Window is not displayed.

The error message will explain the problem. The error is resolved by
correcting the incorrect data or adding any missing information.
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Using Template Tags

What are Template Tags?

Template tags provide a handy way to save you from entering the
same data over and over in your ads. Template tags are code words
that stand for something else. When you insert a template tag into an
ad, TPT replaces the tag with the “something else” when it posts the ad
to eBay.

For example, one of the standard tags is {Field:Title}. This tag
represents the Title field at the top of the Ad Information pane. If you
insert this tag into your ad, the title you enter replaces the tag when
the ad is posted. For example:

Here's the ad title, ... the first line of the ad,  and the first line on
eBay.

B it {Field: Title} Brass Crah

The {Terms} tag saves you lots of time. If your terms of sale are always
the same, you can set up that tag to represent all the text that tells your
terms. Then when you create a new ad, just insert the tag. No need to
type the same terms again and again. Or if you have different terms for
different types of ads, create a tag for each set of terms.

So while the terms and conditions you put into your TPT ad look like
this:

Terms & Conditions:

{Terms}

The terms and conditions you see on eBay could look like this:

Terms & Conditions:

Please e-mail any questions prior to bidding

Payment must be recerved within 12 days of auction close.

Buyer is responsible for a $25 fee charged by my bank

tor any checls returned due to maufficient funds.

Save on shipping by combimng wintung bids from our other auctions.
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Inserting Template Tags

To insert a femplate tag into your ad:

1. While you are editing your ad, position the cursor where you want
the tag.

Select Template Tag |

2. Click the Insert Tag button &l to
open a dialog containing a list of

{ AuctionlserlD}
1Field: Consignld}

tags.
yourtags EFieId: InsurancﬁiFee}
. . Field: InsureFor
3. Chck the tag you want to insert and oy ShippingH andingCosts}
click OK. The tag appears in your {Field: StockMa} [
text enclosed in curly braces, like EE!EH Eli“E}D }
L 1Eld: Lizerllescr
this: {Counter}. Field: ‘Weight}
. {Foater}
Or, instead of steps 2 and 3, you can {Headsr}
type the tag name enclosed in curly {HiddenCourter} hd
braces. TPT will recognize it as a tag
when it prepares the ad for posting. oK Cancel |

However, if no tag by that name exists,
TPT just uses the text you typed,
including the braces. Be sure to
preview your ad (see page 27) and
proof it carefully to catch such
mistakes. .

Creating and Managing Template Tags

To create a new template tag:

You can create your own tags and then use them in your ads. Here’s
how.

1. Select the Tools menu, then Template Tags to open the Template
Tags dialog.

2. Click the plus sign # at the bottom of the dialog to add a new tag or
use Ctrl+T to create a copy of the currently selected tag.

3. Click in the Tag field, and type a name for the tag. Be sure to
enclose it in curly braces. For example {My Tag Name}.

4. In the Type field, select whether you want the tag to represent Text
you enter on this dialog or the content of a Field in the ad.
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5. If you choose a Field type, choose the field name from the Field list.
Or, if you choose a Text type, press the [Tab] keyboard key and
then enter the text, HTML or script in the large white Text box on

the dialog.

Note: If you wish to enter HTML, use the “Hint” on page 50 to
easily create correct HTML text.

. Enter a number for the Replacement Order. The Replacement

Order determines which tags are replaced first. You can use the
Replacement Order to define tags within tags

7. Then click the checkmark + to save your tag.

For example, you might want a fancy signature like this for the end of
your ads.

v Funny Valentine »

Here’s a tag that inserts it.

=loj x|
Tag Order 2| 2] Tag |{MyFanc}'Name} |
{Footert 110
{Header! 120 Type: v Tewst " FieldMame ‘
{Mudctions} 140 Field: | j

b [{MuF ancyM ame} 150 =0
Tems} 150 Replacement Order: -

e Test:  [<P»<FONT size=25 <FONT face=5ymbol ﬂ
A L0 color=Hf000> ®</FONT> < FONTKFONT face="Comic Sans
{Field: Consignl d} oo || MS" color=H#Ff000: <STROMG > Funny
{Field: FlatE achadd } 1000 Walentine< /STRONG> < /FONT»<FONT size=2:<FOMT

3 @

{Field: FIE achaddiz} 1000 face=Symbol> @< FONT></FONT < /P

{Field: FlatE achaddiz} 1000

{Field:FlatShippingH andling } 1000

{Field:FlatShippingH andling2} 1000

{Field:FlatS hippingH andling 3} 1000

{Field:GalleryURL} 1000

{Field:InzuranceFee} 1000

{Field:InsureF or} 1000 [

{Field:Pack ageH andlingFee} 1000

{Field: Paymentinstructions} 1000 -] M | 1 | 4 | L | + | v | - | e ‘ = ‘ rd ‘
To edit a template tag:
1. Select the Tools menu, then Template Tags to open the Template

Tags dialog.
2. In the list, click the name of the tag you want to edit.
3. Click the triangle sign « at the bottom of the dialog to put the
dialog in edit mode.

4. Click in the area you want to edit.
5. Make your changes. Then click the checkmark # to save the tag.
Using Template Tags 45



Hint about entering text for a tag:

Here is the easiest way to enter accurate HTML text into the Text box
for a tag you create:

1.
2.

Create and format the text in the normal TPT editor.

Switch to the HTML editor by clicking the HTML tab below the
editors.

Preview  HTML |

. Find the text you just entered. Highlight all of it from the “<P>”

that precedes it to the “</P>”" that follows it. Do NOT copy the
<body tag with the contentEditable=true. This tag is for internal
TPT use only.

Copy the highlighted text to the clipboard.

5. Use the instructions for editing a tag, and paste (Control+V) the

6.

clipboard contents into the Text box.

Be sure to save the tag before you close the dialog.

That’s how we created the {MyFancyName} tag (page 49) to insert this:

v Funny Valentine »

To delete a tag:

1.

Select the Tools menu, then Template Tags to open the Template
Tags dialog.

. In the list, click the name of the tag you want to delete.

. Click the minus sign = at the bottom of the dialog. TPT asks you to

confirm that you want to delete it.

Confirm |

@ Delete record?
Cancel |

Click OK. (Or click Cancel if you changed your mind.)
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Advanced Template Tags

Tags within Tags (Embedded Tags)

Specifying a replacement order for a Template Tag allows you to
define tags within tags. TPT will replace tags in ascending order of the
replacement tag. Template tags with no replacement order are
replaced first since they float to the top of the list. Tags with no
replacement order are listed in the order of entry into the table. (In
other words, the oldest tags with no replacement order are listed first
and the newer tags with no replacement order are listed last)

The only requirement for embedded tags is that the replacement order
of the embedded tag have a higher replacement order.

Example:

Tag: {tagl}

Text: {tag?}:{Field:Title}
Replacement Order: blank

Tag: {tag?2}
Text: This is the title
Replacement Order: 100

Tag: {Field:Title}
Text:
Replacement Order: 200

TPT will replace {tagl} on the first pass with {tag2}:{Field:Title}
TPT will replace {tag2} and {Field:Title} on the second pass with

This is the title: Auction title from ad

Tags and Image Replacement

Image replacement occurs after all template tags have been replaced.
This means you can define local images in your Template Tags and
TPT will upload them to your FTP server and modify the link
accordingly.
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Working with Ad Lists

The left panel of the TPT window lists your ad folders and shows the
ads of the status you select or in the folder you select.

Status Buttons Status icons Selected Ads

Pozt Stz| DoMotE dit |AuctionMame & | Title —
A | [ | eBay US zample 1
alde = N & eBay US zample 2

----- 1 Sample [2]

L]

a1

Folders you maintain

Status Buttons

Use the jewel-like button to list all ads or the ads with a specific status.

Button Explanation

Click this button to list all your ads, regardless of their

Al ) folder or status. The total number of ads is shown
below the button.
Click this button to list all the ads that will be posted
(Pending ) next time you use the Post Pending Ads tool (see page
41). The number of pending ads is shown below the
button.

Click this button to list all the ads that have already
been posted to eBay. The number is shown below the
button.

Click this button to list all the ads that have been
discarded and await deletion. You can empty the Trash
by Right Clicking on the button and select “Empty
Trash”. You can also restore an ad to its original folder
by selecting the ad in the grid and Right Clicking
“Restore”. The number is shown beside the button.

(Ponea)
v,

User Folders

Click one of the User Folders to list only the ads stored in that folder.
You can create as many of these folders as you need to organize your
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ads, and you determine where each ad is stored. The number beside a
folder name indicates the quantity of ads in the folder.

You can create a folder at any hierarchical level: at the root level so it
always appears in the folders list, or under any other folder so it is a

subfolder.

Top level (root) folders

User Folders |

=1 = Imported from CSW eBlay [151]
-~ £ Shooting Star Ads [23]
‘B Turbo Lister Ads [46]

21 Sample [£]

Subfolders

Each ad is initially placed in the folder that is selected when you create
the ad. You can move any ad to any other folder at any time.

To create a new top level (root) folder:

1. Click the button. A
“New Folder” folder

appears at the bottom of the
list of folders.

Or, right-click the folder
and select Add Root Folder.

2. Right-click the new folder,
and select Rename Folder
from the floating menu.

3. Type a name for the folder,
replacing “New Folder”.

Uzer Folders -

=- D Imported from C5Y eBay [151]
i i (1 Shodting Star Ads [23]

‘o £ Turba Lister Ads [46]

- £ Sample [2]

o = New Folder
Add Root Folder Chrl+lng
Add Folder Inz
Delete Folder Dl

\ Fiename Folder Ctrl+F
kove Folder to Boot Shift+alt+BkSp

Put Ads in Faolder
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To create a new sub-folder:
1. Click the folder under which you want to place the sub-folder.
Or, right click the folder and select Add Folder.

2. Click the @ icon. A new folder appears under the selected folder,
and a plus sign appears beside the selected folder, indicating it has
sub-folders.

3. Right-click the new folder name, and select Rename Folder.

4. Type a name for the folder, replacing “New Folder”.

To remove a folder:

1. Make sure the number beside the folder name is zero. You can
remove a folder only if it contains no ads. If the folder you want to
delete contains ad, move them to another folder first.

2. Click the folder to select it.
3. Right-click the folder and select Delete Folder.

To move ads into a folder:

1. Click the folder that currently contains the ad. The folder icons
shows that the folder is open.

2. Scroll through the Ad List and select the ad or ads you want to
move.

¢ C(lick an ad to select it.

¢ [Shift] + click another ad to select all those in between this one

and the one that was previously selected (a contiguous set of
ads).

¢ [Ctrl] + click another to add it to, or remove it from, the set of
selected ads (a non-contiguous set).

3. Click and drag the selected ads to the folder where you want to
move them.
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The Ad List (Main 6rid)

Hu—- [ |-|:|“ - wha

| eBay LS Moniza - for pouiowill - New CD hn-':lrf :lhl 1 )
. | Barmy b anilow - i'd really love to... MNew heartz_ahoy 3
D eBay LS Lil' Jor & the East Side Bayz - Mew CD heartz_ahoy 3
ﬂ eBay LS Bleszsid Union OF Souls - ight in... Mew heartz_ahoy 3
ﬂ eBay 15 zher - nice & slow - Mew Ch heartz_akoy 3
ﬂ eBay 15 Hanzon - i will come to pou - New CO heartz_ahoy R
1| | [+]

The right side of Pane 1 is a list of all the ads in the selected folder. The
information about each ad appears on a row. The most important
information is contained in the columns on the left side — the ones
that show up without your having to scroll. You can scroll horizontally
to see all the detail information about an ad.

Icons in the Post Status column indicate whether:
£ The ad has been posted.
£ The ad is in the batch to post next.

W TPT encountered problems with the ad during a previous attempt
to post, and the ad was not posted.

Mark the Do Not Edit column if you want to make sure you don’t
accidentally change any information in the ad.

To delete an ad:

¢ Click the ad to select it, then click the Delete Ad tool. You &
can also hit the Delete key on the keyboard. If you are in a *
user folder or system view, “Delete Ad” will send the
selected ads to thr Trash view.

¢ If you are in the Trash view and you click the Delete Ad tool
or Delete key, the ad will be removed from the database
permanently.

To add columns to the Ad List
1. Select “Customize Grid” from the Tools menu
2. . Drag a column from the Customization dialog and drop it in

the grid header. The column will be added where the green
arrows indicate.
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. 2 ;

D_w%uﬂnhl ame
Zelal Customizaktion |

Tes

Columnz |
Tes

:-:
= Falder

MHew |

Oj=iOiLa

To remove columns from the Ad List

1. Select “Customize Grid” from the Tools menu

2. . Drag a column header from the grid and drop it in the
Customization dialog.

el e 1

E

Columnz |

Falder |

To Show or Hide Grid Summary Footer

Select “Show Grid Summary” from the Tools menu. The summary
footer will appear at the bottom of the grid. The summary footer
sums the fee columns for the records in the current view. If you
tilter the view, the summary is adjusted accordingly.
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Filtering and Searching Your Ads

TPT provides many features to help you find the ads you want to view
and track. In addition to organizing them into folders to make them
easy to find (see page 52), you can filter the ads in the Ad List and you
can search for a specific ad based on the information in its details.

Filtering Ads

Filtering ads means selecting certain criteria ads must meet. Only ads
that meet the criteria appear in the list, until you turn off the filtering.

To filter ads in the ad list:
1. Select the folder whose ads you want to filter.

2. Click the Filter tool to display the Filter builder dialog, @
which you use to select the filtering criteria.

3. Click “press the button to add a new condition”

TgFilter builder - [untitled.fit] ) |

@ < roak

| press the button to add a new condition |

Open... || Save Az, ] || Cancel || Apply
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4. Left click the column box (next to the ellipsis button) to select
column.

FaFilter builder - [untitled.ft] x|

AMD <root:

Poszt Status
RIS [ oM otE dit

Auctiont ame

condition

dzerDescr
AuctionldzerlD

Druration

Schedulel ate
StartTime

EndTime

PostD ate

b odified ¥

Open... || Save bz k. || Cancel || Apply

5. Left click the operator box to select the criteria operator.

FaFilter builder - [untitled.ft] x|

AMD <root:

equals -
press the does not equal |

iz lesz than
iz lezz than or equal to
iz greater than

iz Ereater thar or eiual [{u]

ot like

iz blank,

iz nak blank,
between
niok bebween ¥

Open... | Save bz | k. || Cancel || Apply
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6. Type the criteria in the next box. In the example below we are
looking for all titles which begin with “sam”. The % is a wildcard
character which means any one or more characters. You can also
use the underscore character “_" to indicate any one character. If
you wish to save this filter, use the “Save As...” button.

FaFilter builder - [untitled.ft]

AMD <root:

| press the button to add a new condition

Open... || Save bz | k. || Cancel || Apply

7. To remove a criteria, press the ellipses button and select “Remove
Row”

T=Filter builder - [untitled.flt]

AMD <rooky

...... E Title like  samé

Add Condition H & new condition

Add Group

Remove Row

| k. | | Cancel | | Apply

Save Az
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8. Press OK and the grid is filtered. Notice the criteria shows at the
bottom of the grid. Pressing the “Customize...” button will bring

up the filter dialog.

dit | Auctiont ame & [Ti UzerDescr

eBap US Thiz iz a zample

[Title LIKE sam)

To turn off filtering:
¢ Press the x box to remove the filter
¢ Use the check box to turn the filter on and off.

¢ Open the filter dialog and remove the criteria

Finding a Specific Ad

In the Ad List, you can search for a specific ad, based on the
information in any detail field.

To search for an ad:

1. Select the folder whose ads you want to search.

2. Click the Find tool to display the Locate Ad dialog, which
you use to indicate the ad you want to find.
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Locate Ad

—Figld Y alue

—Search Type

[T Caze-sensitive

"~ Exact Match

" Partial Match at Beginning
% Partial Match Arypwhere

—Field
Title =]
Firzt et X Cancel

3. Use the information in the following table to select the filtering

criteria.

4. Click First to find the first matching ad. Once you have found an
ad, click Next to find the next one in the list. (Click Cancel to close

the dialog.)

Dialog Element

What To Do

Field Value

Type the word or phrase to find in the selected Field.

Case Sensitive

Mark this box if the data in the field must be the
same case (upper or lower) as the Field Value. Leave
it unmarked if case doesn’t matter.

Search Type

Mark the button that indicates how the data in the
selected field of an ad must match the Field Value
you entered.

Exact Match. The data in the field must match the
Field Value exactly.

Partial Match at the Beginning. The first characters
in the field must match the Field Value.

Partial Match Anywhere. Any set of characters in the
field must match the Field Value.

Fields

Select the detail field you want to search.
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Importing Ads from Turbo Lister or
Shooting Star

If you have been using Turbo Lister or Shooting Star software to
manage your eBay ads, you can easily import your ad database into
TPT. Note that, information will be missing from your ads if TPT
includes new eBay features not included in Turbo Lister or Shooting
Star.

Here’s how:

1. Select the File menu, then the Import command to open the Import
CSV (comma-separated values) dialog.

Import CSY x|

Filezource
* Shooting Star

" Turbo Lister

" The Poster Toaster

Impart File: |c:xTPT DiatabS5hds o Fitd File |

Drefault Folder: | 25 § j
AuctionM ame Defaultl serl

FleBay 15 thepoztertoaster -
eBay Canada
eB ayp LUK, -
&b ay Australia -
&l ay kMaotorz -

Import File | Cloze

2. Use the following table to make selections on this dialog.

3. Then click Import File. The ads are immediately imported into the
folder you selected.
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Dialog Element

What To Do

FileSource Select the program you used to create the file you
are importing,.
Import File Click the Find File button and select the file to

import. The path and name of the file appears in the
Import File box.

Default Folder

Select the TPT folder where you want the imported
ads to be stored.

Default UserID

Select the User ID you want to associate with all the
imported ads.
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Exporting

Ads

You can export your ads to a comma delimited ASCII text file. Select
“Export...” from the File menu.

Export Data il

Expart Filenarme: |am Files\The Paster Toaste\TPTE*F.ced  Find File |

File Format:

Export records:

Export Data Cloze

% The Poster Toaster
£ Turbio Lister

{* Selected Records
" Current Folder
= All Templates

Dialog Element

What To Do

Export Enter the exact path and filename for your export

Filename file. You can also use the “Find File” button to select
a file. The default filename is TPTEXP.csv and is
saved to the main “The Poster Toaster” directory.

File Format The Poster Toaster Select this option if you wish

to transfer data to another copy of The Poster
Toaster. You can also use this option to back up or
archive ad data

Turbo Lister ™ Select this option if you wish to
transfer data to Turbo Lister™. Please note that not
data will transfer to Turbo Lister. You may have to
re-enter some of the missing data.

Export Records

Limits the records exported.

Exporting Ads




Backup and Restore

Backup Database

You can backup your database by selecting “Backup Database...” from
the File menu. This will bring up the Backup Database dialog seen

below.
x
Last backup date: #A27/2004 10:35:51 AM
Backup filename:
:%Program FileshThe Poster ToasterhTETDATA zi J
Femind me every |'| 3: days on program close
Backup | Cloze |
Field Name | What To Do

Last backup
date

Date and time of the last backup.

program close

Backup Type the exact path and name of the backup file.

filename You can also use the ellipses button at the end of
the field to open the File dialog.
If you wish to create multiple version backups,
change the backup name before you create the
backup file

Remind me TPT will display this dialog every xx days since the

every xx last backup date when you close TPT.

days on

Backup

Create the backup file. All files in your Data
directory, all *.INI files and all filters saved in the
main The Poster Toaster directory are saved.

Backup and Restore
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Restore Database

You can restore your database by selecting “Restore Database...” from
the File menu. This will bring up the Restore Database dialog seen
below.

Restore Database x|

Backup filename:

C: oy documentsi\tpt TRTDAT A, zip _l

[~ Save acopy of current database before restoring backup

Restare Databaze Cloze |

Field Name | What To Do

Backup Type the exact path and name of the backup file.
filename You can also use the ellipses button at the end of
the field to open the File dialog and select the file
you wish to restore.

Save a copy | Check this box if you want TPT to save a copy of

of current the current database. This copy will be saved as
database TPT911.zip in the main The Poster Toaster
before directory

backup

If the restore does not work properly, you can
restore the TPT911.zip file.

Restore Press this button to start the restore process.
Restoring the database will delete the current
database and replace it with the backup.
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Using the Picture Manager

The Picture Manager helps you keep track of all the images TPT
uploaded to your FTP server(s). You can access the Picture Manager
from the Tools Menu.

3 Picture Manager

Tool Bar

Thumbnail of local image

Picture Details

=1al %]

COptions
= | =
[EE
Filter Proof Shest Remove Expired  Upload Pix

—

Loaded | Pending Upload I

List of pictures loaded on server

Filename & [FTPMame |StockFlag |PicturelURL Filename facel.jpg —
convoui_yodad. | haome. hawai http:#/home. StockFlag True

corwoui_podab. | home. hawai http: 4 /home. Serverf'ath

convoui_podab. | ftp. BEpis. col http://BBpi.c Eocilehally £ documents\tpt\
dp_vodal.jpg  |home.hawai http://home. FTPName home.hawau.n.cor!?

. o e 0 e 9 o'\% PicturellRL http://home.hawailir.c...
p_yodaZ.jpg p ‘ \

dp_vodadjpg  |home hawai http: 4 /home. __,/

dp_vodad.jpg | ftp.BEpis.col http://BBpi.c -

dp_vodadjpg | home.hawai O http: 4 /hame.,

dp_ywodahjpg  |home hawai O http://home.

dp_yoda? | home. hawai http: 4 /hame.

. 5 hitp:/fhome Included in the follawing auctions: -
slrm mckenzHB.g home.h_awm http:.-’.fhon'!e. Posté | &diD Auctiontam | Title £ | U seiDesg
glurm mckenzie | fip. BBpix. col http://BBpix.c » : 3118 | eBay US Computer test

| h I Iz‘ [] 3117 |eBay US | Computer test
Bl | Mark Al Stockl Clear &l Stockl ¥ SH5leBayls iCompulertast

Ads containing tLe selected picture

Tool How To Use It
54 Filter. Opens the filter dialog for the Loaded Pictures.
See Page 57 for details on using the filter.
Filker

Using the Picture Manager
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Tool How To Use It

— Proof Sheet. Click to bring up the Proof Sheet Dialog.

The Proof Sheet displays the images stored on your FTP
Proof Sheet. | server which were loaded by TPT.

Proof sheets x|

harne. hawaii.n| images

Select &l | Clear Selection | 10 4| pictures per page

Create proof sheet for all zelected zites | Cloge |

Select All. Select all servers listed.

Clear Selection. De-selects currently selected
records.

Pictures per page. Set the number of pictures to the
proof sheet will display per page.

Create proof sheet for all selected sites. Press to
create the proof sheet based on your selected
site(s).

%

Femaove Ex=pired

Remove Expired. Click to delete pictures from server.
Only pictures which meet the following criteria are
removed:

1. The end date of the auction plus XX days
(Remove picture XX days after auction ends. Set
in the Options | Other Settings)

2. Picture is not marked as a stock photo.

3. Ads with blank end dates are removed
automatically.

Using the Picture Manager
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Tool How To Use It
g Upload Pix. Click to upload any pictures in the “Pending
Upload” view to the default FTP server. The Upload
Upload Pi Pix function is only intended as a manual upload in the

event an ad’s pictures were not loaded correctly. If a
picture does not load correctly, it will be placed in the
“Pending Upload” view with any error messages that
occurred on loading.

Manually Entering a Picture in the Pending Upload View

1.
2.

Click the “Pending Upload” tab.

Click the ¥ button at the bottom of the form to
insert a new record.

Iploadl D

AdlD 1617

Ad eBay 15 - testing
Fil=name

LocalFilePath

StockFlag ]

. Enter the AdID of the ad that needs the picture

uploaded. You can also pick the ad from the
drop down list of the Ad field.

Type the image filename in the Filename field or
use the ellipses button to bring up the file dialog.

Check the “StockFlag” box if you want this image

to remain on the server after the auction has
ended.

. Click the - button to save the record.

Using the Picture Manager
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Tool How To Use It
g Sending all pictures for an ad to the Pending Upload
View
IIpload Fis

1. Select all the ads that need pictures uploaded in
the main grid. If the ad was posted to eBay
already, make sure you select the corresponding
ad from the Posted folder. This will ensure that
the images have the proper end dates. If you are
uploading pictures separately from the Posting
process, send the ads to the Pending view and
then select the ads in the Pending view to send
pictures.

2. Right Click in the grid and select “Send Images to
Pending Upload” or from the Tools menu.

3. Press the “Yes” button when the dialog comes
up.
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Global Search and Replace

The Global Search and Replace (GSR) function allows you to make
mass changes to your ads. You can access the GSR from the Edit menu

or press Ctrl+G.

x
Search Field: Find what:
T —— -
Auction Type J
By [t Mo
Cateqgary ;I
giﬁﬁgﬁz Replace with:
Gallery Optionhs i
Gallery URL J
Inciude In Prosimity S earch
Location - ll
Limit search to: Optione

{+ Selected Records [~ Replace entire contents of selected field

" Current Falder [ Case sersitive

™ Current Folder + Subfolders [ Include "Do Mot Edit records

£ All Uzer Folders
Replace Cloze

Records searched: Records modified:
Use the following table to fill in the fields

Field Name | What To Do

Search Field | Select the field you wish to search from the list.

Find what Type the text you are searching for.

Replace with | Type the text you wish to replace the “Find what”
field with. If you leave this field blank, the GSR
will remove the “Find what” text and replace it
with nothing.

Limit search | Select one of these options to limit the ads

to searched.

Replace Check this box to replace the whole field with the

entire contents of the “Replace with” field. The “Search

contents of for” field is ignored if this box is checked.

selected field
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Field Name

What To Do

Case sensitive

Check this box if you want the search to match the
case otherwise the GSR ignores case.

Include “"Do
Not Edit”
records

.Check this box if you wish to include ads marked
“Do Not Edit” in the search.

Global Search and Replace
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Get eBay Categories

eBay usually adds new categories and subtracts old categories once a
month. eBay also frequently updates the Item Specifics a few times
each month. The “Get eBay Categories” function downloads the latest
categories from the TPT website. You can access this function from the
Help menu. You need to update your categories on a regular basis in
order to post your ads correctly.

Update eBay Categories il

Diownload categanes for the selected auchion]z] below:

rd eBay LS Current TPT Category file date: 2004-07-23 08:03 ;I
¥  eBayCanada

W  eBay UK

W  eBapdustalia

W  eBayMators

¥ Download changes only

+ Get Cateqories | ¥ sbort

To download and install the latest categories

1. Check each box next to the auction house you wish to get categories

for. Only “active” auctions appear in the list. An “active” auction
is marked “active” in the Options for that auction house. (see page
13)

2. Check the “Download changes only” box if you want TPT to
download the categories if there has been a change since the last
time the categories were downloaded. Usually, this box is checked.
Un-checking the box will force TPT to download the most recent
category file regardless of the version already loaded.

3. We try to keep the category file on our website current but if you
notice that the file is out of date, send us an email and we’ll update
them ASAP.

Get eBay Categories
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The Help Menu

Poster Toaster on the Web

This item will take you to the “The Poster Toaster” website. Check out
the latest news and browse the forum for tips and answers.

Make a Donation

We plan to keep the Poster Toaster free for all to use; however, there
are lots of costs involved, including the fees we pay to eBay.

If you find the Poster Toaster valuable, please consider donating.

No donation is too small! (or too large!)

Check for latest updates

Are you running the latest version of TPT? Use this function to check
the TPT website for the latest updates.

The Help Menu
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Troubleshooting

HTML Editor

The ad displayed in the Editor does not match the ad details.

Think of the HTML Editor as a picture frame. When you select an ad,
the current HTML is removed and the new HTML of the selected ad is
placed in the frame. Under certain circumstances, (such as moving
rapidly through slow loading ads) it is possible for the Editor to be out
of synch with the selected ad. In other words, the picture in the frame
belongs to another ad. At this point however, the current ad's HTML is
still intact. If you Reload the saved HTML, the Editor and the selected
ad will be in synch again.

The AdID of the HTML loaded in the Editor appears in the status bar
at the bottom of the Editor window. If the AdID of the loaded HTML
does not match the currently selected ad, the Editor Menu bar will turn
red. If you try to use the Editor, TPT will reload the correct HTML
before allowing you to edit. If you try to save the ad, everything will
save except the ad Description since the two AdIDs do not match.

Detail | User Defined Fisids |
% Title: |Brand new Spiderman DD =
Red menu _
b indi Subtitle: |
ar indicates User Deser | AdID of
thé'lt the Post Status: AdD( 2380 : frtoifred—F = selected
editor is out record
of synch
Reload =
button - =
[Pos: 12 [Modified [Marmal fﬂQID: 109) |
Edit | HTML]

AdID of HTML loaded in editor

For most users, this shouldn't be a problem. However, if you notice
that what's loaded in the Editor does not match the Detail, just press
the Reload button on the Editor ToolBar to synch them up again.
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Database

Collation Sequence Error
You see the following error on startup:

gryAds: Error 7200: AQE Error: State = HY000; NativeError
= 5175; [Extended

Systems] [Advantage SQL] [ASA] Error 5175: The index file was
created with a different

collation sequence than is currently being used. Table name:
Ads

TPT comes with a utility program which will compact and re-index the
database. This should purge the deleted records from the database..
The program is called PosterMaint.exe and is located in The Poster
Toaster directory. There should also be a link in the Windows Start
Menu under "The Poster Toaster" Group.

1. Close The Poster Toaster
2. Run the PosterMaint.exe program.
3. Press the Start button. This will run the compact program.

4. Once it is finished, close the program and start The Poster Toaster.

Troubleshooting
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Error 5004 after restoring the database from backup.

You restored the database from a backup file. The next time you open
TPT you see the following error message:

Error 5004. Either ACE could not find the specified file, or
you do not have sufficient rights to access the file. The data
dictionary is not found on the server.

The restored database file was saved from a different directory than
the current installation of TPT.

Do the following:

1. In the main "The Poster Toaster" directory, look for a file called
ADS.ini

2. Open the file in edit mode. (Double clicking should open NotePad)

The file should look like this:
[Databases]

PTDATA=C:\Program Files\ The Poster
Toaster\DATA\PTDATA.ADD;D

3. Change the path of the PTDATA.ADD file to the correct location on
your computer.

Troubleshooting
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TPT dies on startup

The HTML Editor control depends on three files which need to be
registered properly. Some applications un-register these files for some
reason which then causes TPT to crash.

Download and install the latest version of Microsoft Internet
Explorer™. This may re-register the missing components.

If Re-installing IE does not work, you need to re-register these files to
restore TPT. The three files are:

mshtml.dll
dhtmled.ocx
triedit.dll

Search your hard drive for the exact location of the above files then try
re-registering these files with regsvr32.exe.

Example:
Click on Start -> Run and type:
regsvr32 "c:\<Path to file on your computer>\triedit.dll"

Repkwe“<Path to file on your computer>” with the actual path
to the file on your computer. Repeat the regsvr32 command for the
remaining files using the exact locations on your hard drive.
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